Quartus Il Introduction Using VHDL Design

This tutorial presents an introduction to the Quaftui CAD system. It gives a general overview of a typi-
cal CAD ow for designing circuits that are implemented byings FPGA devices, and shows how this ow is
realized in the Quartus Il software. The design processuistibited by giving step-by-step instructions for using
the Quartus Il software to implement a very simple circuiamAltera FPGA device.

The Quartus Il system includes full support for all of the plgp methods of entering a description of the
desired circuit into a CAD system. This tutorial makes usthefVHDL design entry method, in which the user
speci es the desired circuit in the VHDL hardware descdptlanguage. Two other versions of this tutorial are
also available; one uses the Verilog hardware descripéinglage and the other is based on de ning the desired
circuitin the form of a schematic diagram.

The last step in the design process involves con guring tesighed circuit in an actual FPGA device. To
show how this is done, it is assumed that the user has accssAdtera DE2 Development and Education board
connected to a computer that has Quartus Il software iastalh reader who does not have access to the DE2
board will still nd the tutorial useful to learn how the FPG#ogramming and con guration task is performed.

The screen captures in the tutorial were obtained using theatQs Il version 5.0; if other versions of the
software are used, some of the images may be slightly diftere

Contents:

Typical CAD ow

Getting started

Starting a New Project

VHDL Design Entry

Compiling the Design

Pin Assignment

Simulating the Designed Circuit

Programming and Con guring the FPGA Device
Testing the Designed Circuit



Computer Aided Design (CAD) software makes it easy to imgeta desired logic circuit by using a pro-
grammable logic device, such as a eld-programmable gateyaiFPGA) chip. A typical FPGA CAD ow is
illustrated in Figure 1.
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Figure 1. Typical CAD ow.

The CAD ow involves the following steps:

Design Entry — the desired circuit is speci ed either by means of a schangiagram, or by using a
hardware description language, such as VHDL or Verilog

Synthesis- the entered design is synthesized into a circuit that stmef the logic elements (LES) provided
in the FPGA chip

Functional Simulation — the synthesized circuit is tested to verify its functior@irectness; this simulation
does not take into account any timing issues



Fitting — the CAD Fitter tool determines the placement of the LEs @€ 1in the netlist into the LEs in
an actual FPGA chip; it also chooses routing wires in the thimake the required connections between
specic LEs

Timing Analysis — propagation delays along the various paths in the tteduifrare analyzed to provide
an indication of the expected performance of the circuit

Timing Simulation —the tted circuit is tested to verify both its functionaliwectness and timing

Programming and Con guration — the designed circuit is implemented in a physical FPGA tlyipro-
gramming the con guration switches that con gure the LEsl@stablish the required wiring connections

This tutorial introduces the basic features of the Quartssftware. It shows how the software can be used to
design and implement a circuit speci ed by using the VHDL dhaare description language. It makes use of the
graphical user interface to invoke the Quartus Il commabdsng this tutorial, the reader will learn about:

Creating a project

Design entry using VHDL code

Synthesizing a circuit speci ed in VHDL code

Fitting a synthesized circuit into an Altera FPGA

Assigning the circuit inputs and outputs to speci ¢ pins ba FPGA
Simulating the designed circuit

Programming and con guring the FPGA chip on Altera's DE2 liba

1 Getting Started

Each logic circuit, or subcircuit, being designed with Quail software is called aroject The software works
on one project at a time and keeps all information for thajgmtdn a single directory (folder) in the le system.
To begin a new logic circuit design, the rst step is to creatdirectory to hold its les. To hold the design les
for this tutorial, we will use a directorintrotutorial. The running example for this tutorial is a simple circuit fo
two-way light control.

Start the Quartus Il software. You should see a display amtd the one in Figure 2. This display consists
of several windows that provide access to all the featur&duzfrtus Il software, which the user selects with the
computer mouse. Most of the commands provided by Quartustiiare can be accessed by using a set of menus
that are located below the title bar. For example, in Figuclicking the left mouse button on the menu named
File opens the menu shown in Figure 3. Clicking the left mouseobutin the entrnjExit exits from Quartus Il
software. In general, whenever the mouse is used to selethong, thdeft button is used. Hence we will not
normally specify which button to press. In the few cases whismecessary to use thigght mouse button, it will
be speci ed explicitly.
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Figure 2. The main Quartus Il display.
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Figure 3. An example of the File menu.



For some commands it is necessary to access two or more nreseguience. We use the conventidenul
> Menu2 > Item to indicate that to select the desired command the userghatikclick the left mouse button
on Menul, then within this menu click oMenu2, and then withirMenu? click on Item. For exampleFile >
Exit uses the mouse to exit from the system. Many commands candieeith by clicking on an icon displayed in
one of the toolbars. To see the command associated with anposition the mouse over the icon and a tooltip
will appear that displays the command name.

1.1 Quartus Il Online Help

Quartus Il software provides comprehensive online docuatiem that answers many of the questions that may
arise when using the software. The documentation is actéss®m the menu in thélelp window. To get some
idea of the extent of documentation provided, it is worthe/idor the reader to browse through tHelp menu.
For instance, selectingelp > How to Use Help gives an indication of what type of help is provided.

The user can quickly search through the Help topics by setgetelp > Search, which opens a dialog box
into which key words can be entered. Another method, corgersitive help, is provided for quickly nding
documentation for speci c topics. While using most apgiicas, pressing th&1 function key on the keyboard
opens a Help display that shows the commands availabledapplication.

2 Starting a New Project

To start working on a new design we rst have to de ne a néesign project Quartus Il software makes the
designer's task easy by providing support in the form wfizard Create a new project as follows:

1. Selectile > New Project Wizard to reach the window in Figure 4, which indicates the capihilf this
wizard. You can skip this window in subsequent projects bgcking the boxDon't show me this intro-
duction again. PressNext to get the window shown in Figure 5.

New Project Wizard: Introduction

The Mew Project “Wizard helps you create a new project and preliminary project settings,
including the following:

#  Project name and directory

#  Mame of the top-level design entity
#  Project files and libraries

#  Target device family and device
# EDA tool settings

*f'ou can change the settings for an existing project and specify additional project-wide
zettings with the Settings command [Assignments menu). You can uge the various
pages of the Settings dialog box to add functionality to the project.

™ Don't show me this introduction again

| Mest > | | Cancel |

Figure 4. Tasks performed by the wizard.
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Figure 5. Creation of a new project.

2. Set the working directory to bietrotutorial; of course, you can use some other directory name of your
choice if you prefer. The project must have a name, whichusilisthe same as the top-level design entity
that will be included in the project. Chookght as the name for both the project and the top-level entity, as
shown in Figure 5. Presdext. Since we have not yet created the direciatyotutorial, Quartus Il software

displays the pop-up box in Figure 6 asking if it should crehtedesired directory. Clickes, which leads
to the window in Figure 7.

GQuartus 11 [x]

& Directory "D:/Antrotutorial” does not exist, Do you want to create it?

e [ls] |

Figure 6. Quartus Il software can create a new directorytfergroject.



New Project Wizard: Add Files [page 2 of 5] &|

Select the design files you want to include in the project. Click Add All to add all design files
in the project directory to the project. Mote: you can alwaps add design files to the project
later.

File name: || J

File name Type Add Al

" LEEERE

Specify the path names of any non-default libraries. User Libraries...

< Back | Mest > | Finizh | Cancel |

Figure 7. The wizard can include user-speci ed design les.

3. The wizard makes it easy to specify which existing lesafify) should be included in the project. Assuming
that we do not have any existing les, clidkext, which leads to the window in Figure 8.

New Project Wizard: Family & Device Settings [p... El

Select the family and device you want to target for compilation.

Family: Cyclone Il j
Target device
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EP2C20F256CT Package: Ay -
EP2C20F256CE

EP2C20F 25618 Fin count: Ay -
EP2C20F484C6

EP2C20F484C7 Speed grade:  |Any -
EP2C20F484C3

EPZC20F454/8 Core voltage: 1,24

Eggggggigigg ¥ Show Advanced Devices
EP2C35F484C8
EPZC35F484/8
E ;

Filters

I 2

EP2C35FE72CT
EP2C35FE72CE "
EP2C35FE7218

EP2CE0F484CE [Advanced) g
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Figure 8. Choose the device family and a speci c device.



4. We have to specify the type of device in which the desigiiredit will be implemented. Choose Cyclohé
Il as the target device family. We can let Quartus Il softwagkect a speci ¢ device in the family, or we can
choose the device explicitly. We will take the latter apmtoarom the list of available devices, choose the
device called EP2C35F672C6 which is the FPGA used on A&&?2 board. Predsext, which opens the
window in Figure 9.

New Project Wizard: EDA Tool Settings [page 4 of...@]

Specify the other EDA tools - in addition to the Quartus || software - used with the project.

™ EDA design entry /
synthesis toal: | J
-
[~ EDA simulation toal: | J
-
™ EDA timing analysis tool: | J
-

< Back | Mest > | Finizh | Cancel |

Figure 9. Other EDA tools can be speci ed.

5. The user can specify any third-party tools that shoulddeelu A commonly used term for CAD software
for electronic circuits i€£DA tools where the acronym stands for Electronic Design Automafidris term
is used in Quartus Il messages that refer to third-partystashich are the tools developed and marketed
by companies other than Altera. Since we will rely solely ara@us Il tools, we will not choose any other
tools. Presdext.

6. A summary of the chosen settings appears in the screemshdvigure 10. PresBinish, which returns to
the main Quartus Il window, but witlight speci ed as the new project, in the display title bar, asdatid
in Figure 11.



New Project Wizard: Summary [page 5 of 5]

‘wihen vou click Finish, the project will be created with the following settings:

Project directory:
[: fintrotutorial!

Froject name: light
Top-level design entity: light
Mumber of files added: 1]

Mumber of user libraries added: 0

Device assignments:

Family name: Cyclone ||

Device: EP2C35FET2CE
ED& tools:

Dresign entry/spnthesis: <Mone>

Simulatior: <Mone:

Timing analysiz: <Mone>

< Back | et > I Finizh I Cancel |

Figure 10. Summary of the project settings.
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Figure 11. The Quartus Il display for the created project.



3 Design Entry Using VHDL Code

As a design example, we will use the two-way light controtiiecuit shown in Figure 12. The circuit can be used
to control a single light from either of the two switchas,andx,, where a closed switch corresponds to the logic
value 1. The truth table for the circuit is also given in theairg. Note that this is just the Exclusive-OR function
of the inputsx; andx;, but we will specify it using the gates shown.

X1
X, X | f
0 0 0
A D
[ 10|12
-

Xy

Figure 12. The light controller circuit.

The required circuit is described by the VHDL code in Figuge Mlote that the VHDL entity is callelight to
match the name given in Figure 5, which was speci ed when thgept was created. This code can be typed into
a le by using any text editor that stores ASCII les, or by ngithe Quartus Il text editing facilities. While the

le can be given any name, it is a common designers' practicese the same name as the name of the top-level
VHDL entity. The le name must include the extensighd, which indicates a VHDL le. So, we will use the
namelight.vhd

LIBRARY ieee;
USE ieee.stdogic_1164.all ;
ENTITY light IS
PORT (x1,x2:IN STDLOGIC;
f :OUT STD.LOGIC);
END light ;

ARCHITECTURE LogicFunction OF light IS
BEGIN

f <= (x1 AND NOT x2) OR (NOT x1 AND x2);
END LogicFunction ;

Figure 13. VHDL code for the circuit in Figure 12.

3.1 Using the Quartus Il Text Editor

This section shows how to use the Quartus Il Text Editor. Yauskip this section if you prefer to use some other
text editor to create the VHDL source code le, which we widdmelight.vhd

SelectFile > New to get the window in Figure 14, chooSs#1DL File, and clickOK. This opens the Text
Editor window. The rst step is to specify a name for the leathwill be created. Seleélile > Save As to open
the pop-up box depicted in Figure 15. In the box labebagle as type chooseVHDL File. In the box labeled
File name typelight. Put a checkmark in the bokdd le to current project . Click Save, which puts the le
into the directonyintrotutorial and leads to the Text Editor window shown in Figure 16. Maxirthe Text Editor
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window and enter the VHDL code in Figure 13 into it. Save the by typingFile > Save, or by typing the
shortcutCtrl-s.

New X

Device Design Files l Software Files ] Other Files ]

AHDL File

Block Diagram/S chematic File
EDIF File

Veriloi HOL File

Cancel

Figure 14. Choose to prepare a VHDL le.

Save in; |E} introtutorial ﬂ EF '
db
File name: ligh
Save as type: |WHDL File (*.vhd.” vhd] =] Cancel
Iv Add file to current project

Figure 15. Name the le.

# light.vhd

M=

|~

|

Figure 16. Text Editor window.
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Most of the commands available in the Text Editor are sefflaxatory. Text is entered at thesertion point
which is indicated by a thin vertical line. The insertion potan be moved either by using the keyboard arrow
keys or by using the mouse. Two features of the Text Editoreapecially convenient for typing VHDL code.
First, the editor can display different types of VHDL statts in different colors, which is the default choice.
Second, the editor can automatically indent the text on alimevgo that it matches the previous line. Such options
can be controlled by the settingsTnols > Options > Text Editor.

3.1.1 Using VHDL Templates

The syntax of VHDL code is sometimes dif cult for a designerremember. To help with this issue, the Text
Editor provides a collection o¥HDL templates The templates provide examples of various types of VHDL
statements, such as an ENTITY declaration, a CASE staterapdtassignment statements. It is worthwhile
to browse through the templates by selectitdjt > Insert Template > VHDL to become familiar with this
resource.

3.2 Adding Design Files to a Project

As we indicated when discussing Figure 7, you can tell Qedttsoftware which design les it should use as part
of the current project. To see the list of les already inatddn thelight project, selecAssignments > Settings,
which leads to the window in Figure 17. As indicated on thé dede of the gure, click on the itenfriles. An
alternative way of making this selection is to cho®seject > Add/Remove Files in Project.

Settings - light @
Category:
General
Files
User Libraries [Current Project] Select the desion files you want to include in the project. Click Add All to add all design files in the
Device praject directory ta the praject.

Timing Requirements & Options
EDA Tool Settings . )

File: narne: J
Compilation Process Settings
Analysis & Synthesis Settings File name Type Add 2l
Fitter Settings light. vhd WHDL File
Tirning Analyzer
Diesign Assistant
SignalT ap Il Logic Analyzer
SignalProbe Settings
Simulator
PowerPlay Power Analyzer Settings
Software Build Settings
HardCapy Settings

ULl

F

F

oK Cancel

Figure 17. Settings window.

If you used the Quartus Il Text Editor to create the le and atedl the box labeleddd le to current
project, as described in Section 3.1, then tight.vhd le is already a part of the project and will be listed in the
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window in Figure 17. Otherwise, the le must be added to thejgxt. So, if you did not use the Quartus Il Text
Editor, then place a copy of the leght.vhd which you created using some other text editor, into theatdry
introtutorial. To add this le to the project, click on thigile name: button in Figure 17 to get the pop-up window
in Figure 18. Select thiight.vhd le and click Open. The selected le is now indicated in the Files window of
Figure 17. ClickOK to include thdight.vhd le in the project. We should mention that in many cases thaius

Il software is able to automatically nd the right les to user each entity referenced in VHDL code, even if the
le has not been explicitly added to the project. However,domplex projects that involve many les itis a good
design practice to speci cally add the needed les to thejget as described above.

Select File X

Loak in: |_} intratutorial ﬂ £ B

File name: |Iight.vhd
Files of type: |Design Files [".tdf;".vhd;".vhdl;".v;".vlg;".vh;:j Cancel

Figure 18. Select the le.

4 Compiling the Designed Circuit

The VHDL code in the lelight.vhdis processed by several Quartus Il tools that analyze the,@ohthesize
the circuit, and generate an implementation of it for thgeachip. These tools are controlled by the application
program called th€ompiler

Run the Compiler by selectingrocessing > Start Compilation, or by clicking on the toolbar ico ® that
looks like a purple triangle. As the compilation moves thglowarious stages, its progress is reported in a window
on the left side of the Quartus Il display. Successful (oruansssful) compilation is indicated in a pop-up box.
Acknowledge it by clickingOK, which leads to the Quartus Il display in Figure 19. In the sage window, at the
bottom of the gure, various messages are displayed. In ohseors, there will be appropriate messages given.

When the compilation is nished, a compilation report is guoed. A window showing this report is opened
automatically, as seen in Figure 19. The window can be résim@ximized, or closed in the normal way, and it

can be opened at any time either by selecBngcessing > Compilation Report or by clicking on the icors® .

The report includes a number of sections listed on the ldf sif its window. Figure 19 displays the Compiler
Flow Summary section, which indicates that only one loga@rednt and three pins are needed to implement this
tiny circuit on the selected FPGA chip. Another section isveh in Figure 20. Itis reached by selectiAgalysis

& Synthesis > Equations on the left side of the compilation report. Here we see th&legpressions produced
by the Compiler when synthesizing the designed circuit.eDlesthaff is the output derived as

f = x2%x1

where the $ sign is used to represent the Exclusive-OR aperaDbviously, the Compiler recognized that the
logic expression in our design le is equivalent to this eagsion.
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Figure 19. Display after a successful compilation.

© Compilation Report - Analysis & Synthesis Equations

@ Corpilation Report

Analysis

& Synthesis Equations

& B Legal Motice RILZ = x2 § x=1; -
SFA Flow Summary 0
&BR Flow Settings
&R Flow Elapsed Time --xZ is x2
@ Flow Log —-operation wode is input
- &F 3 dnalysis 8 Synthesis X2 = INPUTI();
S Summary
+ &1 Settings
SR Source Files Read ——x1 iz x1
SR Resource Usage Summary ——operation mode is input
&BR Resource Utilization by Entity B
+- &1 Cptimization Results ¥1 = INFUT():
\l.; Message: _f is £
* gg Fitter ——operation mwode is output
+ Assembler
+-&H(1 Timing Analyzer £ = OUTPUT{A1LZ);
v
gl 3

Figure 20. Compilation report showing the synthesized gons

4.1 Errors

Quartus Il software displays messages produced duringitatiop in the Messages window. If the VHDL design
le is correct, one of the messages will state that the coatigih was successful and that there are no errors.

If the Compiler does not report zero errors, then there isadtlone mistake in the VHDL code. In this case
a message corresponding to each error found will be disglaythe Messages window. Double-clicking on an
error message will highlight the offending statement in\t#DL code in the Text Editor window. Similarly, the
Compiler may display some warning messages. Their detaiide explored in the same way as in the case of
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error messages. The user can obtain more information alkspéa c error or warning message by selecting the
message and pressing thg function key.

To see the effect of an error, open the light.vhd Remove the semicolon in the statement that de nes the
functionf , illustrating a typographical error that is easily madenpde the erroneous design le by clicking on
the ® icon. A pop-up box will ask if the changes made to tight.vhd le should be saved; clickres. After
trying to compile the circuit, Quartus Il software will disly a pop-up box indicating that the compilation was not
successful. Acknowledge it by clickil@K. The compilation report summary, given in Figure 21, now gos
the failed result. Expand th&nalysis & Synthesis part of the report and then selddiessages to have the
messages displayed as shown in Figure 22. Double-click@ngherror message. Quartus Il software responds
by opening thdight.vhd le and highlighting the statement which is affected by thieog as shown in Figure 23.
Correct the error and recompile the design.

Figure 21. Compilation report for the failed design.

Figure 22. Error messages.

& light.vhd M=1E3
LIBRARY ieee ; A
USE ieee.std logic_1164.all ;

ENTITY light IS
PORT { =1, x2 : IN STD_LOGIC ;
£ : OUT  STD_LOGIC )
END light ;

ARCHITECTURE LogicFunction OF light IS
EEGIN
£ <= {x1 AND NOT x2) OR (MOT x1 AND xZj

END LogicFunction ;

Figure 23. Identifying the location of the error.
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5 Pin Assignment

During the compilation above, the Quartus Il Compiler wa®fto choose any pins on the selected FPGA to serve
as inputs and outputs. However, the DE2 board has hardwinatections between the FPGA pins and the other
components on the board. We will use two toggle switchegléats W; andSWj, to provide the external inputs,
X1 andx,, to our example circuit. These switches are connected tBRIGRA pins N26 and N25, respectively. We
will connect the output to the green light-emitting diode labelé&DG ¢, which is hardwired to the FPGA pin
AE22.

Pin assignments are made by using the Assignment Editact@esignments > Pins to reach the window
in Figure 24. UndeCategory selectPin. Double-click on the entrg< new>> which is highlighted in blue in
the column labeled To. The drop-down menu in Figure 25 willegr. Click orx1 as the rst pin to be assigned,;
this will enterx1 in the displayed table. Follow this by double-clicking ore thox to the right of this new1
entry, in the column labeled Location. Now, the drop-dowmma Figure 26 appears. Scroll down and select
Pin_N26. Instead of scrolling down the menu to nd the desired pinjJgan just type the name of the pin in the
Location box. Use the same procedure to assign iR@ub pin N25 and output to pin AE22, which results
in the image in Figure 27. To save the assignments made, elfiles> Save. You can also simply close the
Assignment Editor window, in which case a pop-up box will #sfou want to save the changes to assignments;
click Yes. Recompile the circuit, so that it will be compiled with therect pin assignments.

Figure 24. The Assignment Editor window.

Figure 25. The drop-down menu displays the input and outpotas.
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Figure 26. The available pins.

Figure 27. The complete assignment.

The DE2 board has xed pin assignments. Having nished ongigie the user will want to use the same
pin assignment for subsequent designs. Going through theedure described above becomes tedious if there
are many pins used in the design. A useful Quartus Il featlwe/sthe user to both export and import the pin
assignments from a special le format, rather than creatiregn manually using the Assignment Editor. A simple
le format that can be used for this purpose is t®@nma separated value (CSgymat, which is a common text
le format that contains comma-delimited values. This lerfnat is often used in conjunction with the Microsoft
Excel spreadsheet program, but the le can also be creaté@ihg using any plain ASCII text editor. The format
for the le for our simple project is

To, Location
x1, PINLN26
X2, PINLN25
f, PIN_LAE22

By adding lines to the le, any number of pin assignments cateated. Sucbsv les can be imported into any
design project.
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If you created a pin assignment for a particular project, gani export it for use in a different project. To see
how this is done, open again the Assignment Editor to reaelwthdow in Figure 27. Now, seleEile > Export
which leads to the window in Figure 28. Here, the light.csvis available for export. Click ofexport. If you
now look in the directoryntrotutorial, you will see that the ldight.csvhas been created.

Figure 28. Exporting the pin assignment.

You can import a pin assignment by choosifsgsignments > Import Assignments. This opens the dia-
logue in Figure 29 to select the le to import. Type the nametaf le, including thecsvextension and the full
path to the directory that holds the le, in the File Name baxdgressOK. Of course, you can also browse to
nd the desired le. For convenience, all relevant pin agsigents for the DE2 board are given in the le called
DEZ2 pin_assignment.csiw the directoryDE2 tutorialsndesign les, which is included on the CD-ROM that ac-
companies the DE2 board and can also be found on Altera’'s DHEPpages.

Figure 29. Importing the pin assignment.

6 Simulating the Designed Circuit

Before implementing the designed circuit in the FPGA chiptlom DE2 board, it is prudent to simulate it to
ascertain its correctness. Quartus Il software includésalation tool that can be used to simulate the behavior
of a designed circuit. Before the circuit can be simulatet, hecessary to create the desired waveforms, called
test vectorsto represent the input signals. Itis also necessary tafgpeleich outputs, as well as possible internal
points in the circuit, the designer wishes to observe. Thwikitor applies the test vectors to a model of the
implemented circuit and determines the expected respdtisavill use the Quartus Il Waveform Editor to draw
the test vectors, as follows:
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1. Open the Waveform Editor window by selectifile > New, which gives the window shown in Figure 30.
Click on theOther Files tab to reach the window displayed in Figure 31. Chodsetor Waveform File
and clickOK.

Figure 30. Need to prepare a new le.

Figure 31. Choose to prepare a test-vector le.

2. The Waveform Editor window is depicted in Figure 32. S te under the naméght.vwf, note that this
changes the name in the displayed window. Set the desiradation to run from 0 to 200 ns by selecting
Edit > End Time and entering 200 ns in the dialog box that pops up. Seledtiagy > Fit in Window
displays the entire simulation range of 0 to 200 ns in the wimdas shown in Figure 33. You may wish to
resize the window to its maximum size.
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Figure 32. The Waveform Editor window.

Figure 33. The augmented Waveform Editor window.

3. Next, we want to include the input and output nodes of theudito be simulated. Clicledit > Insert
Node or Bus to open the window in Figure 34. It is possible to type the naa signal (pin) into the
Name box, but it is easier to click on the button labelextle Finder to open the window in Figure 35. The
Node Finder utility has a Iter used to indicate what type ofdes are to be found. Since we are interested
in input and output pins, set the Iter ®ins: all. Click theList button to nd the input and output nodes as

indicated on the left side of the gure.

Figure 34. The Insert Node or Bus dialogue.
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Figure 35. Selecting nodes to insert into the Waveform Edito

Click on thex1signal in the Nodes Found box in Figure 35, and then clickttsggn to add it to the Selected
Nodes box on the right side of the gure. Do the samex@randf. Click OK to close the Node Finder
window, and then cliclOK in the window of Figure 34. This leaves a fully displayed Wave Editor
window, as shown in Figure 36. If you did not select the nhoddhé& same order as displayed in Figure 36,
it is possible to rearrange them. To move a waveform up or dowime Waveform Editor window, click on
the node name (in the Name column) and release the mousabiiie waveform is now highlighted to
show the selection. Click again on the waveform and drag dngiown in the Waveform Editor.

Figure 36. The nodes needed for simulation.

4. We will now specify the logic values to be used for the infighalsx1 andx2 during simulation. The logic
values at the outpdtwill be generated automatically by the simulator. To maleaiy to draw the desired
waveforms, the Waveform Editor displays (by default) \atiguidelines and provides a drawing feature
that snaps on these lines (which can otherwise be invoketdysingview > Snap to Grid). Observe also
a solid vertical line, which can be moved by pointing to it Bmd dragging it horizontally. This reference
line is used in analyzing the timing of a circuit; move it teetime = 0 position. The waveforms can be

drawn using the Selection Tool, which is activated by seigdhe iconk in the toolbar, or the Waveform
Editing Tool, which is activated by the icc#2 .
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To simulate the behavior of a large circuit, it is necessagpply a suf cient number of input valuations and
observe the expected values of the outputs. In a large tit@inumber of possible input valuations may
be huge, so in practice we choose a relatively small (buessptative) sample of these input valuations.
However, for our tiny circuit we can simulate all four inpwluations given in Figure 12. We will use four
50-ns time intervals to apply the four test vectors.

We can generate the desired input waveforms as follows.k @licthe waveform name for thel node.
Once a waveform is selected, the editing commands in the MfawaeEditor can be used to draw the desired
waveforms. Commands are available for setting a seleage@lsio 0, 1, unknown (X), high impedance (2),
don't care (DC), inverting its existing value (INV), or deimg a clock waveform. Each command can be
activated by using thEdit > Value command, or via the toolbar for the Waveform Editor. The Bukénu
can also be opened by right-clicking on a waveform name.

Setx1to 0 in the time interval 0 to 100 ns, which is probably alreadyby default. Next, setlto 1 in the
time interval 100 to 200 ns. Do this by pressing the mouseeaastart of the interval and dragging it to its
end, which highlights the selected interval, and choodiegagic value 1 in the toolbar. Make& = 1 from

50 to 100 ns and also from 150 to 200 ns, which correspond<ttrilh table in Figure 12. This should
produce the image in Figure 37. Observe that the odtgstdisplayed as having an unknown value at this
time, which is indicated by a hashed pattern; its value valbietermined during simulation. Save the le.

Figure 37. Setting of test values.

6.1 Performing the Simulation

A designed circuit can be simulated in two ways. The simplest is to assume that logic elements and intercon-
nection wires in the FPGA are perfect, thus causing no delgydépagation of signals through the circuit. This
is calledfunctional simulation A more complex alternative is to take all propagation dglayo account, which
leads tatiming simulation Typically, functional simulation is used to verify the fetional correctness of a circuit
as it is being designed. This takes much less time, becaasgrtulation can be performed simply by using the
logic expressions that de ne the circuit.

6.1.1 Functional Simulation

To perform the functional simulation, sele&ssignments > Settings to open the Settings window. On the left
side of this window click orSimulator to display the window in Figure 38, chooBanctional as the simulation
mode, and clickOK. The Quartus Il simulator takes the inputs and generatesutpits de ned in thdight.vwf

le. Before running the functional simulation it is necesg#o create the required netlist, which is done by se-
lectingProcessing > Generate Functional Simulation Netlist. A simulation run is started biprocessing >

Start Simulation, or by using the ico®.. At the end of the simulation, Quartus Il software indicatesuccessful
completion and displays a Simulation Report illustrateéigure 39. If your report window does not show the
entire simulation time range, click on the report windowetest it and choos¥iew > Fit in Window. Observe
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that the output is as speci ed in the truth table of Figure 12.

Figure 38. Specifying the simulation mode.

Figure 39. The result of functional simulation.

6.1.2 Timing Simulation

Having ascertained that the designed circuit is functigrarrect, we should now perform the timing simulation
to see how it will behave when it is actually implemented ia tihosen FPGA device. Selgkssignments >
Settings > Simulator to get to the window in Figure 38, choo$aning as the simulation mode, and cli€XK.

Run the simulator, which should produce the waveforms inufeigl0. Observe that there is a delay of about 6
ns in producing a change in the sigriafrom the time when the input signats; andx,, change their values.
This delay is due to the propagation delays in the logic efgrard the wires in the FPGA device. You may also
notice that a momentary change in the valué pfrom 1 to 0 and back to 1, occurs at about 106-ns point in the
simulation. Thigglitch is also due to the propagation delays in the FPGA device,usecehanges ir; andxz
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may not arrive at exactly the same time at the logic elemeitgbnerates.

Figure 40. The result of timing simulation.

7 Programming and Con guring the FPGA Device

The FPGA device must be programmed and con gured to impletherdesigned circuit. The required con gura-
tion le is generated by the Quartus Il Compiler's Assembtardule. Altera's DE2 board allows the con guration
to be done in two different ways, known as JTAG and AS modeg ¢dm guration data is transferred from the
host computer (which runs the Quartus 1l software) to therdbdy means of a cable that connects a USB port
on the host computer to the leftmost USB connector on thedbdar use this connection, it is necessary to have
the USB-Blaster driver installed. If this driver is not aldy installed, consult the tutori@etting Started with
Altera's DE2 Boardfor information about installing the driver. Before usidgtboard, make sure that the USB
cable is properly connected and turn on the power supplychwih the board.

In the JTAG mode, the con guration data is loaded directlpithe FPGA device. The acronym JTAG stands
for Joint Test Action Group. This group de ned a simple way festing digital circuits and loading data into
them, which became an IEEE standard. If the FPGA is con gumetiis manner, it will retain its con guration
as long as the power remains turned on. The con guratiorrinéion is lost when the power is turned off. The
second possibility is to use the Active Serial (AS) mode.hiis tase, a con guration device that includes some
ash memory is used to store the con guration data. Quartusoftware places the con guration data into the
con guration device on the DE2 board. Then, this data is &zhichito the FPGA upon power-up or recon guration.
Thus, the FPGA need not be con gured by the Quartus Il so#vifathe power is turned off and on. The choice
between the two modes is made by the RUN/PROG switch on thelldB2l. The RUN position selects the JTAG
mode, while the PROG position selects the AS mode.

7.1 JTAG Programming

The programming and con guration task is performed as fe#lo Flip the RUN/PROG switch into the RUN
position. Selecflools > Programmer to reach the window in Figure 41. Here it is necessary to $pdioe
programming hardware and the mode that should be used. Hlresdy chosen by default, select JTAG in the
Mode box. Also, if the USB-Blaster is not chosen by defauless theHardware Setup... button and select the
USB-Blaster in the window that pops up, as shown in Figure 42.
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Figure 41. The Programmer window.

Observe that the con guration léight.sofis listed in the window in Figure 41. If the le is not alreadgted,
then click Add File and select it. This is a binary le produced by the Compilekssembler module, which
contains the data needed to con gure the FPGA device. Theneidn.sofstands for SRAM Object File. Note
also that the device selected is EP2C35F672, which is theAFiR®ice used on the DE2 board. Click on the
Program/Con gure check box, as shown in Figure 43.

Figure 42. The Hardware Setup window.

Figure 43. The updated Programmer window.
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Now, pressStart in the window in Figure 43. An LED on the board will light up winéhe con guration data
has been downloaded successfully. If you see an error egpbytQuartus Il software indicating that programming
failed, then check to ensure that the board is properly pewen.

7.2 Active Serial Mode Programming

In this case, the con guration data has to be loaded into treguration device on the DE2 board, which is
identi ed by the name EPCS16. To specify the required comajion device selechAssignments > Device,
which leads to the window in Figure 44. Click on tBevice & Pin Options button to reach the window in
Figure 45. Now, click on th€on guration tab to obtain the window in Figure 46. In the Con guration aev
box (which may be set to Auto) choose EPCS16 and &ligk Upon returning to the window in Figure 44, click
OK. Recompile the designed circuit.

Figure 44. The Device Settings window.
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Figure 45. The Options window.

Figure 46. Specifying the con guration device.

The rest of the procedure is similar to the one describedafmthe JTAG mode. Sele@bols > Program-
mer to reach the window in Figure 41. In the Mode box selsctive Serial Programming. If you are changing
the mode from the previously used JTAG mode, the pop-up bdigare 47 will appear, asking if you want to
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clear all devices. Clickes. Now, the Programmer window shown in Figure 48 will appeaak®lsure that the
Hardware Setup indicates the USB-Blaster. If the con gioratle is not already listed in the window, pregsld
File. The pop-up box in Figure 49 will appear. Select the light.pofin the directoryintrotutorial and click
Open. As a result, the con guration Idight.pofwill be listed in the window. This is a binary le produced by
the Compiler's Assembler module, which contains the datiaetdoaded into the EPCS16 con guration device.
The extensionpofstands for Programmer Object File. Upon returning to thegRnmmer window, click on the
Program/Con gure check box, as shown in Figure 50.

Figure 47. Clear the previously selected devices.

Figure 48. The Programmer window with Active Serial Prognaing selected.

Figure 49. Choose the con guration le.
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Figure 50. The updated Programmer window.

Flip the RUN/PROG switch on the DE2 board to the PROG positieressStart in the window in Figure
50. An LED on the board will light up when the con guration ddtas been downloaded successfully. Also, the
Progress box in Figure 50 will indicate when the con guratand programming process is completed, as shown
in Figure 51.

Figure 51. The Programmer window upon completion of prognamg.

8 Testing the Designed Circuit

Having downloaded the con guration data into the FPGA deyimu can now test the implemented circuit. Flip
the RUN/PROG switch to RUN position. Try all four valuatiosisthe input variables; andx,, by setting the
corresponding states of the switct&®/; andSW,. Verify that the circuit implements the truth table in Figur
12,

If you want to make changes in the designed circuit, rst eltse Programmer window. Then make the
desired changes in the VHDL design le, compile the circaitd program the board as explained above.
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